
                                  CCA-101: Fundamentals of IT & Programming 

                                                                     Assignment -1 

1. What are the four fundamental parts of computer? Explain it with the help of 
diagram. 

 A computer has four main components: Input Units, the central processing unit or CPU, the Primary memory, 
and Output units. Input Unit - The devices to input information, such as a keyboard, and mouse. CPU - The CPU 
is further broken up into 

2: Discuss about the classification of computers based on size and capacity.  

On the basis of size there are four types of computer. They are minicomputer, micro computer, 
mainframe computer and super computer. Super computer is the fastest, most expensive, big in size, and 
most powerful computer that can perform multiple 

3: What is the meaning of computer generation? How many Computer Generations are 
defined? What technologies were/are used? 

 Initially, the generation term was used to distinguish between varying hardware technologies. 
Nowadays, generation includes both hardware and software, which together make up an 
entire computer system. There are five computer generations known till date. ... The period of 
second generation: 1959-1965. Transistor based. 

4: Differentiate between Volatile & Non- Volatile memories.  

Volatile Memory is used to store computer programs and data that CPU needs in real time and is erased once 
computer is switched off. RAM and Cache memory are volatile memory. Where as Non-volatile memory is 
static and remains in the computer even if computer is switched off. ROM and HDD are non-volatile memory 

.5: Distinguish among system software, application software and open source software on 
the basis of their features.    

System software is used for operating computer hardware. On other hand Application software is used by 
user to perform specific task. System software are installed on the computer when operating system is 
installed. ... Some examples of system software's are compiler, assembler, debugger, driver, etc 

 

6. a) Create a file in MS-word to insert a paragraph about yourself and save it with file 
name “yourself”. Describe all steps involved in  

Save a Word document in Open Document Text format 

Click the File tab. 

1. Click Save As. 

2. Click Browse, and then select the location where you want to save your file. 

3. In the Save as type list, click Open Document Text. 

4. Give your file a name, and then save it. 

5.  Select the text you want to modify, 
6.  Click on the font color box on the home tab in the font group  
7.  After words font colors will be appears in front of the mirror  



8.  Then move your cursor on that color  
9.  Lift click on the color what you what to have then finally font color will be change in 

your document.  

 

6 b) Write steps regarding followings  

 To change the font style 

  To change the font size  

CHANGE THE FONT COLOUR 

 

  To highlight (in yellow) the line that reads “need to get IMS’s address”. TO CHANGE THE FONT 
STYLE: 

 First you select the text you want to change in your document , 

 Click on the font style box in the font group on the home tab, then different font styles will 
appears on front of the mirror , 

 Then you just move your cursor over the font styles , then left click on the style what you 
want to modify , 

 Finally font style will be change in your document.   

TO CHANGE THE FONR SIZE: 

 First step select the text what do you want to modify, 

 Then click on the font size box in the font group on the home tab, then font size menu will 
appears in front of the mirror  

 You will move your cursor over the various font sizes on the mirror, left click on the font size 
what you want to use in your document  

 Then font size will be change in your document  

 

TO CHANGE THE FONT COLOUR: 

 Select the text you want to modify, 

 Click on the font color box on the home tab in the font group  

 After words font colors will be appears in front of the mirror  

 Then move your cursor on that color  



 Lift click on the color what you what to have then finally font color will be change in your 
document.  

TO HIGHLIGHT IN YELLOW : 

 “Need to get IMS’s Addres.s            

7. Create a file in MS-Word for the following document and save it with file name ‘ms_word’. 
Describe all steps involved in it. 

Save a Word document in OpenDocument Text format 

1. Click the File tab. 

2. Click Save As. 

3. Click Browse, and then select the location where you want to save your file. 

4. In the Save as type list, click OpenDocument Text. 

5. Give your file a name, and then save   

8. Create a file in MS-word for the following document and save it with file name 
‘equations’. Describe all steps involved in it. 

Equations: 
  X2+Y5=30 
  Z3+Q4=50 
  A2+B8=X2+Y8 

To change a text as subscript 

 First you select the text want to modify, click on the subscript command on the home tab, 
then it will change as a subscript in the document or text a small letter just above the line of text 
again you just click on the subscript command on the home tab, finally it will change as a subscript. 
9. Create a file in MS-word that convert existing highlight text to table as shown below and save it 
as file name ‘text _to _table’. Describe all steps involved in it 

 
if you want to change a text as a table you have to follow the following rules, 
First you select the text want to modify or convert as a table then select the insert tab, after 
words click on the table command then the dialog box will appears in front of the mirror, 
then click on the convert text to table after your left click a new dialog box will appears there 
then you have set the number of columns how many numbers you want after finishing that 
step click ok finally that selected text will convert as a table. 
10. Create a file in MS-Word to insert table in the document. Describe all steps involved in 
it. 
 To insert a new table in your work sheet follow these steps  
First place your insertion point in your document where you insert the table, then select the 
insert tab click on the table command, then drag your mouse over the diagram to select the 
number of columns and rows as you need, finally left click your mouse table will appears in 
your document then you can text inside of the table as you want. 
11. Create a following worksheet in MS-excel and save it with name ‘book1’. 

1. Select the worksheet that you want to use as a template. 

2. Click the File tab. 
3. Under Info, click Save As. 



4. In the File name box, type the name of the worksheet template. To create a 
custom worksheet template, type the file name that you want to use. ... 

5. Do one of the following: ... 
6. Click Save. 

12. Calculate the following things of a range (C2:C11) of date in the worksheet created in 
question number 10. 
To sum of the marks using auto sum in the range of cells (C2:C11): 
 First select the cell where you want to appear function then select the drop down 
arrow next to the AUTOSUM on the home tab, then select the sum, formula will appear 
where you fixed your arrow then you just enter the columns you calculate, then 
automatically cells range will come to that column press ok the result appears. 
Average the marks in the range of cells (C1:C11): 
 Similarly you can calculate the average of that cell, so click on the auto sum symbol  
Select average the formulas appear in the selected cells then enter average will appears. 
Highest marks in the range of cells (C2:C11):& minimum marks i the range of cells 
 Similarly you can calculate the minimum and maximum number of the cells, click on 
the auto sum in the home tab then click on the minimum or maximum what you want 
formula will appears in the cells finally enter total will appear theta it. 

13 a) Describe various steps involved in the following  
 
 To modify column width of a worksheet:  

  First position the cursor over the column line in the column heading then there is a 
 double arrow will appear, left click to the mouse then drag your cursor to increase the width 
 of the column or drag your cursor to the right side to decrease your column width. Then 
 release your mouse. Another step also there to change that.  

 
To modify the row height of a worksheet: 
 First position the cursor over the row line where you want to modify then double 
arrow will appears, left click the arrow drag your mouse to upward to increase your row 
height and drag your mouse to down word  to decrease your row height then remove the 
mouse button. 
 

 To delete rows and columns of a worksheet: 
 First select the row or column where you want to delete then click on the delete 
command in the cells group on the home tab. Then selected row or column will deleted. 

 b) Describe following terms in the worksheet  
 Absolute reference and relative reference in formula 
   Cell reference in formula automatically adjusts to new location when the formula is 
 posted into different cells. This is called relative reference. 
  Sometimes when you copy and paste a formula you don’t want one or more cell 
 reference to change. 
 An absolute reference solves this problem  
 Absolute reference cell reference in a formula always refers to the same cell range. If a  
 formula is copied to a different  location the absolute reference remains the same. 
 Cell address 



  The cell address function is categorized function under excel lookup reference 
 function list of the most important excel function in financial analysis it provide a cell 
 reference. 
 
 
  
 14. What tools are available to customize our PowerPoint presentation? 
  There are many tools available in Microsoft power point to customize. Power  
 point is a most excellent way of presenting to an audience in visual form. It is very 
 different one and different way of presenting your ideas. It helps the speaker and a 
 participant to understand the topic easily. 
 
 
 
 
 
  b) Write the steps for the following action for creation of power point presentation  
 Open a Blank presentation  
  First click on the start button, 
  Then select the power point in Microsoft office  
  Then double click then power point page will open. 
 Save the presentation as Lab1.pptx    
  First you located or select the save command o the access toolbar. 
  If you are saving the file for first time save as command will appears on the 

backstage view. 
  Then you just choose the folder where you want to save the file and gave thet 

file name after words file will be saved on that folder. 
  Save that file name as lab1.pptx. 

Add a Title to the first slide: the name of your college  
 Open the power point slide show page there is a visual will appears that is “click to 
add title” in that place move your cursor over the caption and left click then you can add 
your college name as a title . 
Type your first name and last name in the Subtitle section  
 Same as your title creating there is another caption was appears that is click to 
add subtitle there you can give your name as a subtitle. 
 Add a New Slide which has a Title and Content  
  Here after you want to make a content go to next slide click on the new slide 
then new slide will appear there about your college life and your college you can 
prepare that as a slide show to present in front of your students. 

 
  
 14. What tools are available to customize our PowerPoint presentation? 
  There are many tools available in Microsoft power point to customize. Power  
 point is a most excellent way of presenting to an audience in visual form. It is very 
 different one and different way of presenting your ideas. It helps the speaker and a 
 participant to understand the topic easily. 
 



 
 
 
 
  b) Write the steps for the following action for creation of power point presentation  
 Open a Blank presentation  
  First click on the start button, 
  Then select the power point in Microsoft office  
  Then double click then power point page will open. 
 Save the presentation as Lab1.pptx    
  First you located or select the save command o the access toolbar. 
  If you are saving the file for first time save as command will appears on the 

backstage view. 
  Then you just choose the folder where you want to save the file and gave thet 

file name after words file will be saved on that folder. 
  Save that file name as lab1.pptx. 

Add a Title to the first slide: the name of your college  
 Open the power point slide show page there is a visual will appears that is “click to 
add title” in that place move your cursor over the caption and left click then you can add 
your college name as a title . 
Type your first name and last name in the Subtitle section  
 Same as your title creating there is another caption was appears that is click to 
add subtitle there you can give your name as a subtitle. 
 Add a New Slide which has a Title and Content  
  Here after you want to make a content go to next slide click on the new slide 
then new slide will appear there about your college life and your college you can 
prepare that as a slide show to present in front of your students. 
In PowerPoint, a placeholder is a pre-formatted container on a slide for content (text, graphics, or 
video)  
15. Write steps for creation of a set of PowerPoint slides that demonstrates your skill to 
use the tools of PowerPoint. It should include the following things   
Title slide  &bullet list 
  Inserting Excel Sheet 
  Clip art and Text 
  Slide show effects 

 
the teacher you are, the more PowerPoint will empower you in your work. ... Compare the titles and text for 
each slide to an outline you would have made ... While you click your way through the presentation, look out for 
the following PowerPoint ...  illustrates the Insert menu from which you can choose to include clip art ... 

 

Suggestions: 

 Make sure that all words are spelled correctly. 
 Try different keywords. 
 Try more general keywords. 
 Try fewer keywords. 



 
16. What is the difference between Machine Language and High Level Language? 
Machine language, or machine code, consists of binary code and is the only language that is directly 
understood by the computer. ... Both machine code and assembly languages are hardware specific. 
A high-level language is a programming language that uses English and mathematical symbols in its 
instructions 

17. Discuss about different data types of C programming LanguageData Types 

 int – This data type is used to define an integer number (-…. -3,-2,-1,0,1,2,3….). ... 

 char – Used to define characters. A single character occupy 1 byte. 

 float – Used to define floating point numbers (single precision). Occupies 4 bytes. 

 double – Used for double precision floating point numbers(double precision). 

. 18. Find the output of the following expressions 
 a) X=20/5*2+30-5 
 b) Y=30 – (40/10+6) +10  
c) Z= 40*2/10-2+10 

2x – 2z=6 x = 3. 2/3)-22=6. 6-22=6. - 2z=0. Z=0. 3+2y-3(0) = 15. 2y = 12 y=6 ... 2x+4y - 6z = 30 x – y – 2z = 4 b) 4x – 4y -
 z = 2. - x + y + 2z= -3 

 
 
 
 

 


